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Incorporating language sample analysis into your practice can best be illustrated by working through 
a series of case studies. These cases are from our clinical collaborations with SLPs who have 
graciously granted permission to present their work. We have taken some liberty with commentary 
to explain why certain measures contribute to the overall picture of the oral language skills 
presented by each case. The focus is on the description and diagnostic value of the measures with 
only general consideration of intervention plans. 
 
A main theme of this book is that language disorders take a variety of forms. In each case, LSA 
provides insight into the overall picture of oral language skill in naturalistic, everyday communication 
demands. As you read through these cases, focus on the story that the test scores and language 
sample measures tell us about overall communication effectiveness. The challenging part of our 
work as SLPs is figuring out what it means once diagnostic information is collected. Enjoy the cases 
as they capture a range of oral language problems. For additional case studies, please visit the SALT 
website or go to www.marleenwesterveld.com.



94  Assessing Language Production Using SALT Software  

 

SALT Transcripts: Daniel Nar AGL.slt and Daniel Nar NZPN.slt7 
 
Daniel is 5 years, 10 months old and attends Year 1 of his local primary school (in New Zealand). 
Daniel has a history of speech/language difficulties and has received speech-language intervention 
for articulation, language comprehension, vocabulary, expressive syntax and morphology, and 
phonological awareness. The current language samples were elicited as part of a six-monthly 
intervention review process. 
 
Clinical Evaluation of Language Fundamentals-Preschool (CELF-P2) (Wiig, Secord, & Semel, 2004) 
Word Structure:    SS 6 
Expressive Vocabulary:    SS 9 
Recalling Sentences:    SS 6 
Sum of Expressive language scores:  SS 83 
 
Basic Concepts:    SS 11 
Concepts and Following Directions:  SS 5 
Sentence Structure:   SS 8 
Sum of Receptive language scores:  SS 89 
 
 
The language sample was elicited to review Daniel’s language skills in two language contexts 
relevant to the school curriculum, i.e., story retelling and personal narratives. It was decided to start 
with a warm-up activity as Daniel was unfamiliar with the examiner. This was followed by the story 
retelling task Ana Gets Lost (Swan, 1992), in which Daniel listened to the story once, answered the 
comprehension questions, then listened to the story again, before retelling the story without 
referring to the pictures. Refer to Appendix B for the story retelling protocol. Daniel only answered 
one question correctly (Question: “who found Ana?” Answer: “the policeman”). This puts him well 
below expectations for his age (Fig 9-1).  
 
In between the two exposures to the Ana Gets Lost story, the Personal Narrative section of the 
Language Sampling Protocol was administered (see Appendix C for the prompts and elicitation 
procedures). The examiner adhered closely to the language sampling protocols and Daniel was 
attentive throughout the session and happy to participate. The results are therefore considered to 
be representative of Daniel’s spoken language skills. The samples were recorded using a digital voice 
recorder and transcribed using SALT.  
 
Daniel’s story retelling sample contained 7 C&I utterances and 45 words. His personal narrative 
language sample contained 42 C&I utterances (215 words). Both samples were compared to a 
database of age-matched peers to assign age-specific performance levels. They will be discussed, in 
turn, below. 
 
  

                                                            
7 Daniel’s sample transcripts are included with the software. 

Case Study 1: DANIEL 
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STORY RETELLING (AGL) 

Daniel’s sample was compared to the NZ-AU Story Retell database using the following settings:  
Subgroup: AGL 
Ethnicity: all - Location: all 
Age match plus or minus 6 months 

110 samples matched by age: 5;4 – 6;4 
110 samples based on entire transcript, regardless of length 

Database Menu: Standard Measures Report (Figure 9-1 – next page) 
Daniel produced fewer utterances than his peers to retell the story and the sample contained fewer 
total words compared to the database. In contrast, mean length of utterance in words, number of 
different words, and intelligibility were appropriate. While Daniel produced very few maze words 
(only 2.2%) compared to his peers, his % utterances with errors was significantly higher than his 
peers. He produced significantly more errors at word level than expected for his age – this warrants 
further investigation. 
 
Analyze Menu: Word Code Tables (Figure 9-2) 
To investigate the type of errors Daniel made when retelling the story (he made 6 word errors and 1 
utterance error), the Word Code Tables (Table Expanded by Words & Codes) was selected from the 
Analyze menu. It was noted that most of his errors were pronoun errors. There was also one 

instance of a verb tense error.  
Figure 9-2 
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Figure 9-1 
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Analyze Menu: Bound Morpheme Tables (Figure 9-3) 
Daniel omitted one bound morpheme (/ed). He used two types of bound morpheme when retelling 
the story, present progressive /ing, and past tense /ed. Past tense /ed was used correctly on one 
occasion and omitted on one occasion, resulting in %Obligatory context of 50%. 
 

Figure 9-4 
 
Database Menu: Explore Plus Line Values - ONQ 
The quality of Daniel’s story retelling was analyzed using the Oral Narrative Quality Rubric (see 
Appendix B). Daniel obtained a total score of 16, which was hand coded and the template was 
inserted at the end of the transcript (Edit > Insert Template > Oral Narrative Quality (AGL)). Scores 
for individual characteristics were: intro: 1;  theme: 3; main: 3; supporting: 1; conflict: 1; coherence: 
1;  resolution: 3; conclusion: 3. 
 
Comparing Daniel’s performance to that of his peers reveals (see Standard Measures Report – Figure 
9-1) below average performance.  
 
Database Menu: Explore Plus Line Values - ONC 
 
Daniel’s story comprehension was evaluated using the ONC (see Appendix B). Daniel obtained a total 
score of 1, which was entered and the template was inserted at the end of the transcript (Edit > 
Insert Template > Oral Narrative Comprehension (AGL)).  
 
Comparing Daniel’s performance to that of his peers reveals (see Standard Measures Report – Figure 
9-1) severely below average performance (i.e. more than 3SD below the mean).  
 
INTERPRETATION OF DANIEL’S STORY RETELLING PERFORMANCE 
 
The results from the SALT analysis indicates poor performance in story retelling in areas of verbal 
productivity (number of utterances), grammar (pronouns and verb tense), story quality, and story 
comprehension. Because the story retelling sample only contained 7 utterances, it is important to 
analyze a longer language sample (e.g., the personal narratives), so that a more complete analysis of 
Daniel’s strength and weaknesses across the domains of semantics, syntax, and morphology can be 
conducted.  
You may choose to run a Database: Quick Look report.  
 
Alternatively you can create a Performance Report (Database: Performance Report):  
 
Performance Report 
Daniel Nar AGL 
Age: 5;10 
Language Sample Analysis with SALT Software 
Elicitation Task and Database Overview 
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Daniel completed a narrative story retell of 'Ana gets lost' (Swan, 1992). He listened to the story once and 
was then asked 8 comprehension questions. He listened to the story a second time and then retold the 
story using his own words, without the use of the pictures. Measures of sample length, intelligibility, 
narrative quality, comprehension, syntax/morphology, semantics, verbal facility, and errors were 
calculated from his language sample and compared with samples from 110 speakers completing the same 
task. These speakers were within 6 months of Daniel's age. Although most measures were calculated from 
the entire sample, a few measures, such as total pause time and number of errors, can be affected by 
different sample lengths, i.e., the longer the sample, the more opportunity to produce them. For these 
measures, Daniel's sample was compared with a subset of 97 samples matched in length by the same 
number of words. All measures were interpreted using a standard deviation interval of 1.00 SD. 
 
Transcript Length 
Daniel produced 7 utterances using a total of 45 words, which were both less than his database peers 
completing the same task. His number of utterances and words were 1.21 SD lower and 1.24 SD lower, 
respectively, than the database mean. He took 59 seconds to complete this task, which was within normal 
limits. 
 
Intelligibility 
Daniel's sample was 100% intelligible. 
 
Macro Analysis 
The Oral Narrative Quality rubric was used to assess the structure and content of Daniel's narrative. The 
following categories were included: introduction, theme, main character, supporting characters, conflict, 
coherence, resolution, and conclusion. Daniel's composite score of 16 out of a possible 40 points was 1.22 
SD below the database mean of 24.16. He demonstrated particular difficulty with the category of 
supporting characters. 
 
Comprehension 
After listening to the story for the first time, Daniel was asked 8 comprehension questions. He answered 1 
of them correctly, which was more than 3 SD below the database mean of 7.39. 
 
Syntax/Morphology 
Daniel's mean length of utterance (MLU) in words was 6.43, which was within the normal range 
compared to his database peers. His MLU in morphemes was 6.86, which was also within the normal 
range. 85.7% of Daniel's utterances contained verbs with an average of 1.29 verbs per utterance. The 
percent of utterances with verbs was lower than the database mean by 1.18 SD, while the average 
number of verbs per utterance was within normal limits. 
 
Semantics 
Daniel used 32 different words (NDW) within an analysis set of 45 total words (NTW). This compares 
with database means of 46 different words within 83 total words to complete the same task. NDW can be 
affected by the length of the sample, so the moving-average NDW was calculated for the database samples 
by averaging NDW across the sample, looking at each set of 44 NTW. This showed that Daniel's NDW was 
within the normal limits, indicating typical vocabulary diversity. 
 
Verbal Facility 
Daniel's rate of speech, at 46 words per minute, was within the normal range. No pauses were marked in 
his sample. None of the words in Daniel's sample were filled pauses, false starts, repetitions, or 
reformulations. This was a strength at 1.40 SD lower than the database mean of 12.0% of the words. 
 
Errors 
100.0% of Daniel's utterances contained errors, which was more than 3 SD higher than the database 
mean. He omitted the past tense bound morpheme once, although he produced it once. He used the 
present progressive bound morpheme twice. His sample contained the following pronoun errors: 
HE[EP:SHE] once, HIM[EP:SHE] twice, and HIS[EP:HER] once, the following extraneous word: OF[EW], 
and the following other word-level error: TAKE[EW:TOOK]. His sample also contained the following 
utterance-level error: 
C Anna was go/ing out of the door [EU].  
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PERSONAL NARRATIVES (NZPN) 
 

Daniel’s personal narrative sample was compared to the NZ-AU Personal Narrative database using 
the following settings:  

129 samples matched by age: 5;4 - 6;4 
119 samples matched by age and same number of analysis-set utterances (42) 

 

Figure 9-4 
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Database Menu: Standard Measures Report (Figure 9-4) 
 Transcript Length: Daniel produced a total of 57 utterances of which 15 were either incomplete 

or unintelligible.  
 Intelligibility: Intelligibility was only 89% (well below expectations).  
 Syntax/Morphology: Daniel produced significantly shorter utterances than his peers. Closer 

inspection of his utterance types reveals there were no complex sentences (containing 
dependent clauses). There was also a higher than expected number of errors. This warrants 
further investigation.  

 Semantics: Number of Different Words (NDW) was within normal limits.  
 Verbal facility: Mazing behavior was within normal limits. However, there was a higher than 

expected number of within utterance pauses.  
 
Additional information is provided in subsequent reports. 

 
Analyze Menu: Word Code Tables (Figure 9-5) 
To investigate the type of errors Daniel made when narrating personal narratives, the Word Code 
Tables (Table Expanded by Words & Codes) was selected from the Analyze menu. Daniel showed 
two instances of overgeneralization, pronoun errors, and two prepositional errors. 
 

 
Figure 9-5 
 
Analyze menu: Utterance Code Tables (Figure 9-6) 
As shown in Figure 9-6, the errors at utterance level consist of word order difficulties and omission 
of clauses. Further visual inspection of Daniel’s language sample shows little syntactic complexity. 

Figure 9-6 
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INTERPRETATION OF PERSONAL NARRATIVES – MACROSTRUCTURE 
 
Inspection of Daniel’s personal narratives from a quality point-of-view shows difficulty relating a past 
event narrative. Using McCabe and Rollins’ (1994) narrative structure scoring procedure, the 
following conclusions can be drawn: 

1. Are there two past tense events? – Yes 
2. Are there more than two past tense events? – No 

Furthermore, his narratives are often difficult to understand and do not take the listener’s 
perspective into consideration (see Figure 9-7 for an example). 
 

 Figure 9-7 
 
OVERALL PERFORMANCE 
 
Strengths 
Daniel was happy to participate in the tasks and seemed to enjoy the story as well as the photos that 
were used in the personal narrative task. He showed adequate vocabulary in both narrative 
conditions (NDW), which is in line with his performance on the Expressive Vocabulary subtest of the 
CELF-Preschool. Mazing behavior was not an issue. His mean length of utterance in story retelling 
was within normal limits.  
 
Challenges 
Daniel’s language sample results reveal difficulties with grammar at word- and utterance-level. This 
is in line with the results from the CELF-Preschool which showed impaired performance on subtests 
measuring expressive morphology and syntax (Word Structure and Recalling Sentences). Specific 
difficulties include overgeneralization errors (e.g., “feeled”, “sealices”), pronoun errors, and verb 
tense errors. At utterance-level, Daniel shows difficulty constructing sentences using correct word 
order.  
 
Daniel’s verbal productivity was low as characterized by a short story retelling sample, and low 
number of total words in both the retelling and the personal narrative contexts. Daniel only 
produced 42 utterances in the personal narrative condition (compared to a mean of 85 utterances 
for children aged 5;4 – 6;4). 
 
At macrostructure level, Daniel’s ability to retell a good quality story (ONQ) was below expectations. 
He also demonstrated difficulty relating a personal narrative containing more than two past events. 
His ability to answer questions related to a story was also well below expectations (ONC). This 
finding seems in line with his performance on the Concepts and Directions subtest of the CELF-P. 
 
Finally, intelligibility was low in the personal narrative condition and needs further investigation. 
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Clinical Impressions 
Daniel is a child who has a history of speech and language difficulties. Daniel’s performance on the 
CELF-P, a standardized broad-spectrum language test, indicates low average performance in 
receptive language and just below average performance on expressive language subtests. Despite 
reportedly satisfactory performance following speech and language intervention, and standardized 
test results that indicate a ‘mild’ language impairment, the language sample analysis results clearly 
show the significant difficulties Daniel has in two spoken language contexts that are highly relevant 
to the (New Zealand) education curriculum. The results indicate that during a typical school day 
Daniel will struggle understanding novel stories, will have difficulty retelling stories, and will be 
unable to effectively share his personal experiences during show and tell. LSA results also reveal the 
significant difficulties Daniel has in applying grammatical rules at word- and sentence-level and 
provide descriptive detail across the domains of syntax and morphology that is needed to set 
intervention goals.  
 
Ideas for Intervention 
Recommendations include: 

 Working on story grammar to aid comprehension and retelling of fictional stories (see 
Westerveld & Gillon, 2008).  

 Direct instruction on syntax and morphology within narrative contexts. 
 Introducing a personal narrative structure template to aid personal narrative organization 

(to include orientation, past tense events, evaluation).  
 Practising personal event narratives, using the template and scaffolding from the examiner. 



 Chapter 9     Pulling It All Together: Case Study 2 (LUCY)   103 

 

 

SALT Transcript: Lucy NZPN.slt8 
 
BACKGROUND 
Lucy is a 12;6 year old girl with Down syndrome who attends her local year 1-8 mainstream primary 
school. Lucy has received speech and language therapy services from infancy. She currently receives 
services via a consultative service delivery model once per school term. She also receives teacher 
aide support services in the classroom for five hours per week.  
 
ASSESSMENT MEASURE 
Lucy completed a Personal Narrative language sample as part of a wider assessment of her speech, 
phonological awareness, and literacy skills. The narrative was elicited using the NZ Personal 
Narrative protocol (see Appendix C). Lucy’s personal narrative sample was cut after the presentation 
of 10 photo prompts, and contained 102 complete and intelligible utterances. There is no age-
matched database comparison for Lucy’s personal narrative sample, with the NZ-AU Personal 
Narrative database containing samples from children aged between 4;5 and 7;7. One method for 
interpreting the language sample measures is to compare the sample to those from younger 
children, based on cognitive age or language age, with the assumption that they would have 
comparative language profiles. However, such a comparison does not fully take into account the 
impact of cognitive delay, years of schooling, or life experiences on the children’s language skills, nor 
the phenotypic language profile associated with Down syndrome. Lucy’s transcript differs 
significantly on all language measures from samples taken from the youngest group of children in 
the database. Therefore this case study will examine language measures independent of a database 
using measures taken from the Analyze menu, and analyzing both Lucy and her examiner’s 
performance.  
 
ADDITIONAL ASSESSMENT MEASURES 
 

New Zealand Articulation Test (Moyle, 2004) 
This single word articulation test assesses single and multi-syllabic words elicited by naming pictures. 
The test was normed on New Zealand children, with standard scores available for children aged 5;0 
to 7;11. The sample was transcribed via broad transcription and analysed using PROPH (Long, Fey, & 
Channel, 2008).  
 

Percent Consonants Correct Revised (PCC-R): 88.5 
PCC early: 89.7 
PCC mid: 89.2 
PCC late: 79.5 
Percent Vowels Correct (PVC): 94 
 
Clinical Evaluation of Language Fundamentals – Preschool Edition 2 (CELF-P2) (Wiig et al., 2004) 
Phonological awareness subtest Raw Score: 24/24 
 
Burt Word Reading Test- New Zealand Revision (Gilmore, Croft, & Reid, 1981) 
This single-word decoding test assesses a child’s ability to read real words. Words are presented on a 
sheet in order of increasing difficulty. The test provides age-equivalence bands for children aged 
over 6. 
Raw score: 50 
Equivalent Age band: 8;1 - 8;7 (girls’ norms) 
                                                            
8LucyNZPN.slt is one of the sample transcripts included with the software 

Case Study 2: LUCY 
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Neale Analysis of Reading-Revised (NARA; Neale, 1999).  
This reading test consists of a series of passages of increasing difficulty. The child is required to read 
each passage aloud to achieve a reading accuracy score, with any reading inaccuracies prompted or 
corrected by the examiner. Subsequently, children are required to answer a number of questions 
related to the story to achieve a reading comprehension score. The test is standardized on Australian 
children and provides normative data on reading levels of children in their first seven years of 
schooling. Reading age-equivalent scores in (years;months): 
Accuracy: 8;3 
Comprehension: 6;10 
Rate: 8;9 
 
SALT ANALYSIS 
 

Analyze Menu: Standard Measures Report (Figure 9-8) 
Lucy produced a total of 116 utterances, of which 102 were complete and intelligible (C&I). Lucy’s 
mean length of utterance in morphemes (MLUm) was extremely low at 3.43. Her number of 
different words used was 148 words and she omitted 9 words. Intelligibility was 85.8%, but was 
influenced by the fact that Lucy had her fingers in her mouth during one of the narratives. Her maze 
words as a percentage of total words was low at 6.6%. Finally, she made one word level error and no 
utterance level errors. We did notice a high number of omissions. 
 

 
Figure 9-8 
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Analyze Menu: Syntax/Morphology Summary (Figure 9-9 & 9-10) 
Lucy’s very low MLU in morphemes (MLUm) warrants further investigation. The Syntax/Morphology 
Summary reveals her MLUm equates to an expected age range of 28-45 months, which appears low 
considering her reading ability. As shown in the Utterance Distribution Table (Analyze > Utterance 
Distribution Table), although Lucy was able to produce some longer sentences, nearly 60% of her 
utterances had an MLUm of 3 or less.  
 

 
Figure 9-9 

 
Figure 9-10 
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Analyze Menu: Bound Morpheme Tables (Figure 9-11) 
Next, Lucy’s use of bound morphemes is investigated. Lucy used the bound morphemes plural s and 
es, possessive s, irregular and regular past tense (ed), ing forms, and contractions (copula, negative, 
and auxiliary). Furthermore, she did not omit any obligatory bound morphemes. 

Figure 9-11 
 
Analyze Menu: Standard Word Lists (Figure 9-12) 
To further investigate Lucy’s low MLUm, her use of conjunctions was examined. The list of 
conjunctions, selected from the Standard Word List Tables, shows Lucy used predominantly and, 
with limited use of but, or, and so.  

Figure 9-12 
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Analyze Menu: Omissions and Error Codes (Figure 9-13) 
Next, the high incidence of omitted words (9) needs further inspection. The Omissions and Error 
Codes report reveals that Lucy often omits the subject of the sentence (omitted words are preceded 
with an asterisk). When reading through Lucy’s personal narratives transcript, it is noticed that she 
frequently starts with a single word or abbreviated phrase without the subject and on occasion she 
also omits the verb.  

Figure 9-13 
 
Explore Menu (Figure 9-14) 
Lucy’s use of nonspecific vocabulary such as thing, thingy, and thingy-ma-bob suggests that she may 
have low expressive vocabulary or experience word finding difficulties. The Explore menu was used 
to look at all the words beginning with “thing” (select Explor > List > Word and Code List: enter 
thing=, click OK). In the dialogue box (Explore >List) select Total utterances as the Utterance Base 
and click Expand words and codes (under List Words and Codes) and click List. This will ensure we 
look for “thing=” anywhere it occurs in the transcript. Figure 9-14 shows the results. 

Figure 9-14 
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Macrostructure analysis of personal narrative quality  
Lucy’s personal narratives were analyzed and coded for personal narrative quality (PNQ) with the 
best three narratives analysed using “high point analysis” (McCabe & Rollins, 1994). The narratives 
of children with typically developing language normally follow a developmental sequence of two-
event narratives by age 2 to 3;6, leapfrog narratives by age 4, end-at-high-point narratives by age 5, 
and classic narratives by age 6 (McCabe & Rollins, 1994). Lucy was able to produce narratives which 
demonstrated an ability to correctly sequence past tense events including one example of a classic 
narrative (the dentist) where the narrative built to a high point with a resolution (see also van 
Bysterveldt, Westerveld, Gillon, & Foster-Cohen, 2012).  
 
INTERPRETATION 
 
Lucy’s language production is characterized by low MLUm and simplified sentence structure. These 
skills appear out of line with her other spoken and written language skills. Lucy’s intelligibility is 
further reduced by her stop-start speech and finger mouthing.  
 
Strengths 
Lucy was engaged with the task and was responsive during the assessment. She enjoyed the visual 
prompts and was enthusiastic about relating her own narrative. With support Lucy was able to 
sequence her ideas to relay a series of past tense events in a chronological order with a high point 
and resolution.  
 
Challenges 
Lucy has a very low MLUm which gives her language a telegraphic quality. She has difficulty 
connecting her ideas and needs considerable support from her listening partner to enable her to get 
her ideas across. She struggles to find specific words for items and events and resorts to generic 
words such as thing or thingy. Lucy also uses phrases such as “that’s handy” which she uses as a 
filler-phrase to give herself time to think or as a place holder for her turn, but this is not always 
appropriate.  
 
Clinical impressions 
The stop-start nature of Lucy’s narrative along with the low MLUm results in making Lucy a 
challenging discourse partner. When recalling her personal narrative, Lucy frequently began with a 
single word or abbreviated phrase without the subject and on occasion she also omitted the verb. As 
well as requiring a considerable amount of effort by the listener to make sense of the narrative, 
Lucy’s narrative lacked cohesion and was not easy to follow. When a repetition of the word or 
phrase was provided by the listener, Lucy was then able to expand on the narrative using longer 
phrases and more complete sentences. This required patience and support by the listener to enable 
Lucy to tell her story. These challenges are likely to limit Lucy’s opportunities to engage with her 
peers and to contribute in the classroom setting.  
 
Ideas for Intervention 

 Vocabulary enrichment around topics to support Lucy to participate more fully in class-, 
peer-, and teacher interactions. 

 Linking ideas using coordinating conjunctions to create longer and more complex sentences 
and reduce the telegraphic nature of her narratives. 

 Use of a personal narrative graphic organizer to provide visual supports for Lucy to recall, 
sequence, and organize her ideas. 

 Improve metalinguistic awareness by providing Lucy with feedback when she is not 
understood.  
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SALT Transcript: Carter PGHW.slt9 
 
BACKGROUND 
 

Carter is 8;1 and is in the second grade. He is diagnosed with Autism Spectrum Disorder (ASD) and 
Attention Deficit Hyperactivity Disorder (ADHD). He has a normal IQ according to neuro-
psychological testing. He is receiving speech/language services for speech articulation, which has 
improved his speech intelligibility. Carter also received therapy services as a preschooler that 
focused on expressive/receptive language and social skills. He is being assessed for language skills 
following teacher concerns and SLP observations of difficulty with utterance formulation in both 
speaking and writing. Carter was attentive to assessment tasks and followed directions well 
throughout the evaluation.  
 
ASSESSMENT MEASURE 
 

A story retell narrative task was the best choice to assess Carter’s presenting language challenges. 
The narrative task challenged his word, utterance, and text-level proficiency, and the skills required 
for the narrative closely mirror the demands of the school curriculum. Carter listened to the story 
Pookins Gets Her Way (Lester, 1987) and then retold the story using the book with the text covered. 
He listened carefully to the instructions and gave his best effort retelling the story. The results are 
considered to be representative of his oral language skills. The recorded sample was transcribed and 
then coded for sentence complexity (SI, see Appendix O) and narrative structure and content (NSS, 
see Appendix P). It took Carter 5½ minutes to retell the story and his sample contained 480 words 
and 46 utterances. Carter’s sample was compared to samples selected from the Narrative Story 
Retell database (see Appendix I).  
 

Selected database samples:  
82 samples matched by age: 7;7 - 8;7 
39 samples matched by age and same number of total words (NTW) 

 
Database Menu: Standard Measures Report (Figure 9-15) 
 Transcript Length: The sample was age appropriate in length for the number of utterances and 
words, as well as elapsed time. 

 Intelligibility: Intelligibility did not impact the sample.  
 Macro Analysis: Analysis of the Carter’s story revealed that his NSS Composite Score, although low, 
was within the normal range of performance.  

 Syntax/Morphology: MLU in words and morphemes were also within normal limits. However, 
Carter’s utterances, while of appropriate length, did not include the more complex structure 
typical for his age and grade. This was evidenced by the SI Composite Score, a measure of clausal 
density.  

 Semantics: Carter’s number of different words (NDW) was higher than the database average. So 
was his Moving-Average NDW, a comparison of NDW which is independent of sample length. 
These are measures of vocabulary diversity and the positive SDs indicate a strength in the area of 
semantics.  

 Verbal Facility: Carter’s rate of speech was comparable to his peers at 86.75 Words per Minute 
(WPM). Also noted were a high number of pauses within utterances at 1.80 SD above the database 
mean. Slightly over 25% of Carter’s words were maze words. This is just over three standard 
deviations higher than the database mean and warrants a more in-depth look at mazes.  

                                                            
9 Carter PGHW is one of the sample transcripts included with the software. 

Case Study 3: CARTER 
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 Errors: 17% of Carter’s utterances contained errors, which was within normal limits. However, 
Carter’s sample contained 2 omissions and 11 errors which should be examined for patterns. 

 
SALT ANALYSIS 
 

 
Figure 9-15 (Standard Measures Report based on entire transcript) 
 
 
Database Menu: Quick Look (Figure 9-16) 
The Quick Look report is generated from the database menu and provides a very broad overview of 
skills in an easy-to-read table format, which is convenient for summary meetings to show strengths 
and weakness. Carter’s Quick Look shows that his relative weaknesses are in SI (syntax skills) and in 
Verbal Facility, specifically a high number of mazes. His relative strength is his semantic skills 
(Moving-Average NDW).  All other language measures were within normal limits.  
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Figure 9-16 (Quick Look based on entire transcript) 
 
Based on these reports, additional information would be valuable for several measures: SI, mazes, 
and error codes. Additional information is provided in subsequent reports.  
 
Database Menu: Subordination Index (Figure 9-17) 
The Subordination Index (SI) is a relatively fast way to document the use of complex syntax (see 
Appendix O). This is an important measure from Carter’s sample to confirm the SLP’s observation of 
infrequent use of complex syntax and the frequent mazes which may be associated with utterance 
formulation problems, i.e., limited command of complex syntax. SI is a measure of clausal density, 
calculated by dividing the number of clauses by total number of utterances. SALT calculated the 
score and compared it to the matched database samples. Carter’s SI composite score was 1.13, 
which is 1.81 SD below the database mean of 1.30. Most of his utterances contained one clause. 
 

Figure 9-17 (SI based on the first 312 words) 
 
Database Menu: Verbal Facility Summary (Figure 9-18) 
The Verbal Facility Summary shows that Carter produced mazes at the word and phrase level. His 
word-level mazes were mostly repetitions while the revisions were more prominent at the phrase 
level. These data points provide support for both word retrieval as well as utterance formulation 
problems. 
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Figure 9-18 (Verbal Facility Summary: Maze Summary based on the first 312 words) 
 
Explore Menu: Utterances without mazes (Figure 9-19)  
To better understand Carter’s frequent use of mazes, let’s examine his utterances which don’t 
contain any mazes. 

Figure 9-19 
 
Notice that all of the fluent utterances had simple syntax (grammatical form). Was he attempting to 
produce more than one proposition at a time without command of complex syntax to accomplish the 
task? Further analysis of complex syntax is warranted. Also notice that the code [REF] was applied 
during transcription to mark referencing difficulty, which may be contributing to word retrieval 
impairment. The [REF] code was applied to the troll character because Carter referred to this 
character previously as an elf.  
 
Analyze Menu: Standard Utterance Lists (Figure 9-20)  
Selecting “Utterances with Error Codes” from the Standard Utterance Lists displays all the words and 
utterances coded as errors. This follow-up report should be used to look for patterns of errors. 
Carter made several pronoun errors, e.g., it for them, her for his, and several word-choice errors, 
e.g., before for after, and elf and troll both used to refer to the same character. 
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Figure 9-20 

STANDARDIZED TEST INFORMATION 
 
Clinical Evaluation of Language Fundamentals-5th Edition 
Language Domain with Composite Score: 
Core Language: 76 
Receptive Language: 59 
Expressive Language: 80 
Language Content: 78 
 
Peabody Picture Vocabulary Test-4 (PPVT-4) 
Standard Score: 116 
Percentile: 86 
Age Equivalent: 8;9 
 
Expressive Vocabulary Test: 2 (EVT-2) 
Standard Score: 117 
Percentile: 87 
Age Equivalent: 8;1 
 
Database Menu: Performance Report (Figures 9-21a & 9-21b) 
 
And to “pull it all together”, SALT includes the Performance Report. This report provides a cohesive 
narrative summarizing the language sample analysis outcomes, noting both strengths and 
weaknesses. This report can be edited to add your clinical impressions and incorporate outcomes 
from standardized testing and/or other informal measures. Or just copy and paste relevant 
information from this report into your own report format. The Performance Report is extremely 
comprehensive and can save a lot of time when writing up reports. 
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Figure 9-20b 

Figure 9-20a 
  
 
 

 
 
  

Performance Report 
Carter PGHW 
Age: 8;1, Grade: 2 
 
Language Sample Analysis with SALT Software 
 
Elicitation Task and Database Overview 
Carter completed a narrative story retell of 'Pookins Gets Her Way' (Lester, 1987). He listened to the 
story and then retold the story using his own words. Measures of sample length, intelligibility, 
syntax/morphology, semantics, verbal facility, and errors were calculated from his language sample and 
compared with samples from 82 speakers completing the same task. These speakers were within 6 
months of Carter's age. Although most measures were calculated from the entire sample, a few 
measures, such as total pause time and number of errors, can be affected by different sample lengths, 
i.e., the longer the sample, the more opportunity to produce them. For these measures, Carter's sample 
was compared with a subset of 40 samples matched in length by the same number of words. All 
measures were interpreted using a standard deviation interval of 1.00 SD. 
 
Transcript Length 
Carter produced 46 utterances using a total of 479 words in 5 minutes and 32 seconds, which were all 
within normal limits for this task. 
 
Intelligibility 
Carter's intelligibility was within normal limits with 90.9% intelligible utterances and 98.6% intelligible 
words. 
 
Syntax/Morphology 
Carter's mean length of utterance (MLU) in words was 7.78, which was within the normal range 
compared to his database peers. His MLU in morphemes was 8.75, which was also within the normal 
range. 97.5% of Carter's utterances contained verbs with an average of 1.42 verbs per utterance. The 
percent of utterances with verbs was within normal limits while the average number of verbs per 
utterance was lower than the database mean by 1.09 SD. 

Semantics 
Carter used 141 different words (NDW) within an analysis set of 311 total words (NTW). This compares 
with database means of 129 different words within 321 total words to complete the same task. NDW 
can be affected by the length of the sample, so the moving-average NDW was calculated by averaging 
NDW across the sample, looking at each set of 100 NTW. Carter produced a moving-average NDW of 
64, which was 1.67 SD above the database mean of 57, indicating relative strength in vocabulary 
diversity. 
 
Verbal Facility 
Carter's rate of speech, at 87 words per minute, was within the normal range. Carter's sample 
contained 8 within-utterance pauses for a total time of 30 seconds, with an average pause time of 3.75 
seconds. The total number of pauses and total pause time were both higher than the database mean by 
1.83 SD and 2.10 SD, respectively, while the average pause time was within normal limits. His sample 
also contained 9 between-utterance pauses for a total time of 23 seconds, with an average pause time 
of 2.56 seconds. These between-utterance pause values were within normal limits. Pause time as a 
percent of total time was 16.0%, which was within normal limits. In Carter's sample, 25.4% of the words 
were filled pauses, false starts, repetitions, or reformulations. This percentage of words in mazes was 
2.53 SD higher than the database mean of 11.3%. His sample contained 37 mazes, which were found in 
62.5% of his utterances. Carter's mazes consisted of a high number of both phrase-level and word-level 
revisions and repetitions. A high number of pauses and mazes may indicate difficulty with word 
retrieval and/or utterance formulation. 
 
Errors 
21.7% of Carter's utterances contained errors, which was comparable to his database peers. He omitted 
the past tense bound morpheme once, although he produced it 19 times. He used the plural bound 
morpheme 18 times, the 3rd person singular bound morpheme once, the present progressive bound 
morpheme twice, and the contracted verb form four times. He also omitted the word UP once. His 
sample contained the following overgeneralization error: STICKED[EO:STUCK] twice, the following 
pronoun errors: HER[EP:HIS] and IT[EP:THEM], and the following other word-level errors: 
BEFORE[EW:AFTER] once, ELF[EW:GNOME] once, MAKE[EW:MADE] once, and TROLL[EW:GNOME] 
twice. His sample also contained the following utterance-level error: 
        C Finally, when she is big, (the) the elf (ask/ed :02) ask/3s, "(are y*) you (made a w* not wise choice 
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INTERPRETATION 
 

Performance Profile 
Carter’s language sample results are consistent with the word retrieval and utterance formulation 
profile. His simple sentence attempts are produced without mazes, consistent with limited complex 
syntax use and confirmed by the SI measure. The Verbal Facility Summary provides evidence for 
both word retrieval as well as utterance formulation issues. The phrase level mazes are revisions for 
the most part, while repetitions are at the word level. His pauses within utterances fit these 
observations as his repetitions and revisions did not create enough time to find the right word or the 
syntax to combine more than one idea into one utterance. 
 
Strengths 
Carter was enthusiastic and enjoyed listening to and retelling the story. He used diverse vocabulary 
with number of different words (NDW) being 145, which is slightly higher than the database mean. 
And his Moving-Average NDW, a measure of NDW which is independent of sample length, was 
significantly higher than the database mean. He also had adequate mean length of utterance at 7.8. 
These results are substantiated by his score on the Expressive Vocabulary Test, where he scored well 
above average on single word expression. Another area of relative strength is the length of his story. 
Carter told the story in average time and his story contained an average number of words and 
utterances. 
 
Challenges 
Carter’s sample contained an abundance of mazes (repetitions, revisions, and filled pauses) with 
25% of his words being maze words. His mazes consisted of part-word, word, and phrase repetitions 
as well as word and phrase revisions. The prevalence of pauses within utterances, at 1.80 standard 
deviations above the mean, indicates that he spent more time pausing within an utterance than age-
matched peers. This might indicate difficulty with word retrieval as well as overall utterance 
organization. Word-level errors were also common throughout Carter’s sample. Errors included 
overgeneralization, e.g., sticked for stuck, and pronoun errors, e.g., it for them and her for his. Of 
note, Carter was inconsistent when referring to one of the main characters in the story; the gnome. 
He referred to the gnome as elf, and troll but not gnome. Carter requested from the clinician the 
name of the main character, Pookins, saying that he forgot her name. Some of these errors suggest 
delays in specific areas of language, overgeneralization of past tense, and lack of complex sentence 
use. The frequent mazes suggest that his self-monitoring of language production results in numerous 
changes to get the utterance that he has in mind produced correctly. Improving verbal fluency will 
require both direct instruction on complex syntax and strategies to find the right word. 
 
Clinical Impressions 
Carter performs in the average range on standardized tests. With the exception of his receptive 
language on the CELF-5, all other language domains are in low-average range. His receptive language 
score may be due to reduced attention to the task versus actual issues with auditory 
comprehension. When looking at his score on the PPVT-4 and EVT-2, Carter presents as though he 
has very high expressive and receptive language skills, which is true in some aspects as he has an 
average MLU and NDW. However, these tasks are decontextualized and isolate language in a way 
that does not assess functional language. When Carter has to use the whole language system 
simultaneously, i.e., comprehend picture book, organize thoughts, formulate utterances, his 
language system breaks down and he demonstrates utterance and word retrieval difficulties along 
with pauses. This can be frustrating as he has complex ideas as well as strong vocabulary skills but 
cannot always get his intended message across to the listener. He also uses gestures and non-
specific vocabulary to convey his ideas.  
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Ideas for Intervention 
Recommendations include: 
 Working on references so the listener clearly knows who/what Carter is talking about 
 Word retrieval strategies, e.g., description, synonyms, etc. 
 Taking time to formulate and organize thoughts before talking 
 Direct instruction on complex syntax within a narrative context 
 Fluency practice producing only simple sentences, one proposition at a time 
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SALT Transcript: Max Expo.slt10 
 
BACKGROUND 
 
Max is 11;2 and is in the 5th grade. He began receiving speech/language services when he was four 
years old. He was identified with a learning disability in the first grade. Teacher concerns include 
difficulty expressing himself in a clear and concise manner. In speech-language therapy Max has 
been working on word retrieval, thought organization, and staying on topic. Max's conversational 
skills are very good. It is unlikely that someone would realize he has a language impairment from a 
casual conversation with him. He asks appropriate questions, makes appropriate comments, stays 
on topic (most of the time), and listens to his partner.  
 
ASSESSMENT MEASURE 
  
Max completed an expository language sample where he was asked to tell how to play his favorite 
game or sport. The expository task began with a planning phase of 3-5 minutes where Max was 
asked to make notes on a template addressing ten required categories for a complete exposition. 
Max chose to explain how to play the board game Monopoly. He was compliant during the task and 
appeared to give his best effort. The recorded sample was transcribed and then coded for sentence 
complexity (SI, see Appendix O) and expository structure (ESS, see Appendix Q). Max’s sample was 
compared to samples selected from the Expository database (see Appendix J). 
 
Selected database samples:  

88 samples matched by age: 10;8 - 11;8 
83 samples matched by age and same number of total words (NTW) 

 
  

                                                            
10 Max Expo is one of the sample transcripts included with the software. 

Case Study 4: MAX 
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SALT ANALYSIS 

Figure 9-22 (Standard Measures Report based on entire transcript) 
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Database Menu: Standard Measures Report (Figure 9-22) 
 Transcript Length: Max’s expository sample was somewhat shorter in terms of number of 
utterances, number of words, and time than what was produced by his age-matched peers.  

 Macro Analysis: Max’s ESS Composite Score, which measures the structure and content of the 
exposition, was more than 3 SDs below the database mean.  

 Syntax/Morphology: Max’s average utterance length was shorter than expected with MLUw at 
1.44 SD and MLUm at 1.59 SD below the database mean. His SI Composite Score, which measures 
clausal density, was low.  

 Semantics: Number of different words (NDW) was 1.68 SD below the database average and his 
Moving-Average NDW, a more meaningful comparison of NDW because it is independent of 
sample length, was also below the mean at -1.48 SD. These measures indicate weak semantic 
skills. Perhaps eliciting a language sample from another context would provide evidence to 
determine whether or not this is of significance. 

 Verbal Facility: All measures were one or more standard deviations from the database means. 
Max’s rate of speech, measured in words per minute, was 1.23 SD below the database mean. The 
low rate of speech was a result, at least in part, of the high number of silent pauses. Almost 30% of 
Max’s words were in mazes and he abandoned over 6% of his utterances.  

 Errors: 15.6% of the utterances in Max’s sample contained errors which was within normal limits 
for the task.  

 
Based on this report, additional information would be especially valuable in several areas: Macro 
Analysis (low ESS), Syntax/Morphology (low MLU and SI), and Verbal Facility (low WPM, high number 
of pauses, mazes, and abandoned utterances). Additional information is provided in subsequent 
reports.  
 
Database Menu: Expository Scoring Scheme (Figure 9-23) 
The Expository Scoring Scheme (ESS, see Appendix Q) was used to score the structure and content of 
Max’s expository sample. His sample was scored on ten categories such as preparations, rules, and 
terminology. Most of these categories are based on the planning sheet that Max used to complete 
his expository sample. Max’s composite score was 15 out of 50 compared to an average composite 
score of 32.8 for age-matched peers. The structure and content of Max’s expository language 
sample was in the minimal/emerging range for his age.  
 

 
Figure 9-23 
 
Database Menu: Syntax/Morphology Summary (Figure 9-24 & Figure 9-25) 
 
Max’s MLU in words and morphemes was lower than his age-matched peers. 
The Syntax/Morphology Summary from the Database menu (Figure 9-24) was produced to try and 
gain further information about words and utterances produced in his sample. This report can often 
assist in determining if there are particular forms that may be the primary contributor to low MLU. 
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Max produced fewer total bound morphemes than his age-matched peers retelling the same story, 
though he used similar types of bound morphemes, e.g., contractions, plurals, and possessives. 
However, Max omitted 3 words in obligatory context compared to the database mean of less than 1.  
 
The low MLU can be validated by looking at the Number of Utterances by Utterance Length 
distribution tables (Figure 9-25). Notice that Max’s sample contained three utterances which were 
only 1 – 3 words in length, while none of the database samples contained such short utterances. 
Also, only 5 of his 30 utterances contained more than 11 words compared to the database mean of 9 
out of 21 utterances. 
 

 
Figure 9-24 (Syntax/Morphology Summary based on the first 265 words)  

 
 

 
Figure 9-25 (Utterance Distribution Table based on utterances in the first 265 words)  
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Database Menu: Subordination Index (Figure 9-26) 
 
The Subordination Index (SI, see Appendix O) was applied to Max’s sample. The SI measures clausal 
density and is computed by dividing the total number of clauses by total number of C-units. Max 
yielded a composite score of 1.28 whereas the database mean for age-matched peers is 1.66. Max’s 
score was 1.45 SD below the database mean. He used mostly one-clause utterances (14 total) and 9 
two-clause utterances. 
 

 
Figure 9-26 (SI based on the first 265 words)  

 
Database Menu: Verbal Facility Summary  
The Verbal Facility Summary gives detailed information about speaking rate, pauses, and mazes, 
comparing this information to the database. Each of these sections is highlighted and described 
below. 
 
 Rate and Pause Summary (Figure 9-27) 

Max’s sample was 4 minutes, 2 seconds in length which was within normal limits for the 
expository task. His speaking rate was slower than age-matched peers and his sample contained 
a larger number of pauses. His sample contained 10 within-utterance pauses, which totaled 38 
seconds and lasted, on average, 3.8 seconds. Max also had 5 between-utterance pauses, which 
totaled 12 seconds and lasted 2.4 seconds on average. 
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Figure 9-27 (Verbal Facility Summary: Rate and Pauses based on first 265 words) 
 

 Maze Summary (Figure 9-28) 
 
29.7% of Max’s total words were in mazes. This is 3.56 standard deviations higher than the 
database mean. The number of total mazes was also high as was the average words per maze, 
indicating that he produced frequent and relatively long mazes. Max’s mazes were made up of 
primarily phrase revisions and word repetitions. The maze distribution tables revealed that a 
high percentage of utterances, even utterances that were relatively short, contained mazes. In 
fact, Max had mazes in most of his utterances that were longer than 2 morphemes. Compare 
Max’s values with the much lower database mean values provided in this distribution table. As 
the length of his utterances increased, mazes continued to be present. 
 

 
 
Figure 9-28 (Verbal Facility Summary: Maze Summary based on first 265 words)    
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Analyze Menu: Abandoned Utterances (Figure 9-29) 
The Standard Measures Report (see Figure 9-22) indicated that Max abandoned 6.3% of his 
utterances which was 2.39 SD above the database mean. Since abandoned utterances are not 
common at this age level, with most speakers producing less than one abandoned utterance, it 
would be valuable to look at Max’s abandoned utterances. The Standard Utterance Lists, selected 
from the Analyze menu, displays lists of various types of utterances, including Abandoned 
Utterances, as well as their context within the sample. Max’s language contained two abandoned 
utterances. These utterances are displayed in context with 2 preceding and 2 following utterances. 
 

 
Figure 9-29 
 
INTERPRETATION  
 

Performance Profile  
The delayed language profile is characterized by low mean length of utterance, low number of 
different words, slow speaking rate, and word and utterance-level errors. Max’s language 
production fits into this profile. His syntax was limited to simple sentences with few attempts at 
complex sentence forms as evidenced by his low SI scores. All of Max’s language sample scores 
contribute to his low scores on the ESS in that his sample is short and syntactic forms do not allow 
him to express complex relationships.  
 
Strengths 
As mentioned earlier, Max has good conversational skills. He was a willing participant in the 
assessment process and made only a few word or utterance errors.  
 
Challenges 
Max demonstrated limited lexical diversity with low MLU and NDW. His low SI score indicates that 
he uses simple syntax with limited use of subordination. Verbal fluency was decreased as evidenced 
by increased mazes and pause times. This could be related in part to utterance formulation difficulty. 
Max’s ESS scores indicated problems with cohesion, e.g., overall flow of the sample, organization, 
sequencing, etc., and terminology, e.g., adequately defining new terms. Max also scored lower on 
the content of his expository sample in areas such as explaining how the game is scored, strategies 
used, and preparations for the game.  
 
Clinical Impressions   
Max’s performance could be related in part to formulation difficulties as seen by the length of his 
mazes and the fact that mazes were present even in short, simple utterances. The expository task is 
challenging but revealing of his oral language issues. Comparing his conversational skills with his 
expository skills may suggest opportunities to improve his overall verbal output. 
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Ideas for Intervention 
 Foster vocabulary enrichment, such as pre-teaching content words related to specific areas of the 

curriculum  
 Organize thoughts before speaking by practicing with the ESS matrix to fulfill expectations for 

detail 
 Practice narrative retell to improve sequencing of events and story structure 
 Teach complex sentence forms beginning with conjunctions to expand utterances
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SALT Transcript: Timmy FWAY.slt11 
 
BACKGROUND 
 

Timmy is a 5-year, 8-month old boy who was in early childhood when he first received therapy for 
language delay. He is now in kindergarten and his therapist wants to assess his language production 
using a story retell as it relates directly to the kindergarten curriculum. 
 
ASSESSMENT MEASURE 
  

Timmy completed a narrative story retell using the wordless picture book Frog, Where are You? 
(Mayer, 1969). First, the clinician told the story using a script, and then Timmy retold the story using 
the pictures from the book. Timmy completed the task without prompting and the therapist thought 
the sample was a valid indicator of his current level of oral language. The recorded sample was 
transcribed and then coded for sentence complexity (SI, see Appendix O) and narrative structure 
(NSS, see Appendix P). Timmy’s sample was compared to samples selected from the Narrative Story 
Retell database (see Appendix I). 
  

Selected database samples:  
69 samples matched by age: 10;8 - 11;8  
66 samples matched by age and same number of total words (NTW) 

 
SALT ANALYSIS 
 

Database Menu: Standard Measures Report (Figure 9-30) 
 Transcript Length: Timmy used significantly fewer utterances, words, and time to retell the story 
than his age-matched peers.  

 Macro Analysis: Timmy’s NSS Composite Score, which measures the structure and content of the 
narrative, was 1.83 SD below the database mean. 

 Syntax/Morphology: Timmy’s MLU in words and morphemes was lower than his age-matched 
peers though his SI Composite Score, a measure of sentence complexity, was within the normal 
range for his age.  

                                                            
11 Timmy FWAY is one of the sample transcripts included with the software. 

Case Study 5: TIMMY 
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Figure 9-30 (Standard Measures Report based on entire transcript) 

 Semantics: Timmy’s Number of different words (NDW) was 1.62 SD below the database average; 
however the Moving-Average NDW, a more meaningful comparison of NDW because it is 
independent of sample length, was within normal limits. 

 Verbal Facility: Timmy’s words per minute (WPM) score was within the normal range for his age. 
His sample contained very few mazes or a significant number of silent pauses.  

 Errors: Although about 20% of Timmy’s utterances contained errors, this was not significantly 
more than his age-matched peers. 

 
Based on this report, additional information would be especially valuable in several areas: Macro 
Analysis (low NSS) and Syntax/Morphology (low MLU). Additional information is provided in 
subsequent reports.  
 
Database Menu: Narrative Scoring Scheme (Figure 9-31) 
Timmy’s sample was scored using the Narrative Scoring Scheme (NSS), a tool to assess the structure 
and content of a narrative (see Appendix P). Timmy’s composite score on the NSS was 13 out of 35, 
which is -1.83 SDs below the mean compared to age-matched peers. Timmy had lower scores on the 
categories of introduction, mental states, and cohesion. He appeared to have difficulty grasping the 
structure of the narrative task. 
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Figure 9-31 
 
Database Menu: Syntax/Morphology Summary (Figure 9-32 & Figure 9-33) 
Timmy’s MLU in words and morphemes was lower than his age-matched peers. 
The Syntax/Morphology Summary from the Database menu (Figure 9-32) was produced to try and 
gain further information about words and utterances produced in his sample. This report can often 
assist in determining if there are particular forms that may be the primary contributor to low MLU. 
Timmy produced more plural and possessive bound morphemes than his age-matched peers 
retelling the same story and his overall use of bound morphemes is comparable to age-matched 
peers from the database samples. However, Timmy uses fewer verbs/utterance. 
  

 
 
Figure 9-32 (Syntax/Morphology Summary based on the first 139 words) 



128  Assessing Language Production Using SALT Software  

 

 
The low MLU can be validated by looking at the Number of Utterances by Utterance Length 
distribution table (Figure 9-33). His utterances primarily clustered in length between three and eight 
words. This seems reasonable since his MLU in words was 5.79. 
 

 
Figure 9-33 (Utterance Distribution Tables based on utterances in the first 139 words)  

 
Database Menu: Subordination Index (Figure 9-34) 
The Subordination Index (SI) was applied to Timmy’s sample. The SI is a fast measure of complex 
syntax, computed by dividing the total number of clauses by total number of C-units (see Appendix 
O). Timmy yielded a composite score of 1.05 which is within normal limits compared to the database 
mean. This means that most of his utterances contained one clause. 
  

 
Figure 9-34 
 
Analyze Menu: Omissions and Error Codes (Figure 9-35) 
The Omissions and Error Codes report lists all of the omissions and error codes marked in the 
transcript. In this transcript, there were two omitted words and three word-level errors. According 
to the Standard Measures Report (Figure 9-30), omissions and errors are within normal limits when 
compared to peers. However, they should be looked at in case there are patterns of errors that 
could be identified. Notice that all three error codes marked problems with verbs, including two 
instances of over-generalized past tense verbs. 
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Figure 9-35 
 
INTERPRETATION 
 
Performance Profile  
Timmy’s language production is characterized by low MLU. His sample was far shorter than those of 
his age-matched peers and his narrative organization and structure scores revealed his story was less 
mature and effective. This fits the profile of delayed language which is often associated with low 
MLU and shorter samples.  
 
Challenges  
Timmy produced a short narrative with short utterances. His vocabulary use, albeit not significantly 
lower than his peers, did lack overall diversity and use of verbs. Timmy simply did not talk very 
much. His short sample contained several errors and he had difficulty with the narrative task. It 
would be beneficial to elicit another sample, possibly a conversation, to determine if MLU and 
vocabulary diversity increase.  
 
Strengths  
Timmy’s sample contained very few mazes and the number of errors produced were not significant 
compared with his database peers. 
 
Clinical Impressions 
Overall, Timmy’s sample reveals a reticent talker, possibly because he has not been a successful 
communicator. His limited verbal output may account for his low scores for syntax and limited ability 
with narrative structure. He is a fluent speaker with slightly limited lexical diversity, using mostly 
simple syntax.  
 
Ideas for Intervention 
 Set up language-facilitating games to encourage more verbal output 
 Provide vocabulary enrichment related to curriculum phrases with increased length and mature 

forms 
 Practice story retell using the NSS scoring categories to teach story structure 
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SALT Transcript: Alex 16;7 Con.slt12 
 
BACKGROUND 
 

Alex is a 16;7 year-old high school sophomore who has received special education services since age 
seven for speech and language. In addition, he currently receives support services for math and 
language arts. His productive language skills are being assessed as part of his three-year 
Individualized Education Plan (IEP) re-evaluation.  
 
ASSESSMENT MEASURE 
  

A conversational sample was collected as part of an assessment of Alex’s spoken language skills. Alex 
was cooperative throughout the elicitation process. The results are considered to be an accurate 
representation of his oral language ability. The sample was transcribed using SALT software and SALT 
transcription conventions. There is no age-matched database comparison for Alex’s conversational 
sample since the Conversational database contains samples from participants in the age range 2;9 to 
13;3 (see Appendix G). Two options are available to help interpret the language sample measures. 
An informal option is to compare his sample to the oldest age group from the Conversation 
database. It seems reasonable to assume that a 16-year-old should have at least the skills of a 13-
year-old. However, there may be unknown factors which come into play suggesting that this might 
not be a valid comparison. The other option is to use the Analyze menu which produces language 
measures for Alex and the examiner, but does not include normative data. For this case study we will 
use the second option and look at his measures independent of the database. To help with 
interpretation, SALT contains a variety of graphs generated from the SALT reference databases. They 
are included as PDFs accessible by selecting “Normative Graphs” from the Help menu. For 
conversational samples, data is presented for ages 3 – 13. 
 

Criteria: Measures produced from the Analyze menu 

                                                            
12 Alex 16;7 Con is one of the sample transcripts included with the software. 

Case Study 6: ALEX 
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Figure 9-36 
 
Analyze Menu: Standard Measures Report (Figure 9-36) 
The Standard Measures Report is an overview report showing scores for each of the standard 
language measures. Data from the normative graphs computed from the SALT Conversation 
database (Appendix G) for 13-year-olds (13;0 – 13;11) are used below to help with interpretation. 
 
 Transcript Length: Alex produced a total of 70 utterances in his four-minute, five-second sample; 
twice as many utterances as the examiner.  

 Intelligibility: There were no significant issues with intelligibility.  
 Syntax/Morphology: Alex’s MLUw was 8.78, which is likely within normal limits considering the 
context of the sample (conversation) and his age (16;7). His SI Composite Score indicates that his 
utterances contained an average of 1.33 clauses. Note that the normative graphs for 13-year-olds 
show a mean MLUw of 6.0 and a mean SI composite score of 1.2.   

 Semantics: His Moving-Average NDW (number of different words based on a window of 100 
words) was 63, an indication that his vocabulary diversity was adequate. Note that the normative 
data graph for ages 7 - 13 show a mean Moving-Average NDW of approximately 60. 
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 Discourse: Alex’s turn length in words was 25.87 compared to the examiner’s 6.29 words. Alex 
responded to just 67% of questions posed by the examiner. Note that the normative data graph 
13-year-olds show a mean turn length in words of 12.4 and a mean response to questions of 85%. 

 Verbal Facility: Alex’s speaking rate, measured in words per minute (WPM), appeared elevated at 
164.57. His % mazes (maze words as a % of total words) was 13.1%. Note that the normative data 
for 13-year-olds show mean WPM of 116 and mean % mazes of 8%. 

 Errors: There were five error codes in the sample; 7.1% of Alex’s utterances contained one or more 
errors. Note that the normative data graph for 13-year-olds shows mean % utterances with errors 
of just over 5%. 

 
Additional information is provided in subsequent reports. 
 
Analyze Menu: Standard Utterance Lists  Questions (Figure 9-37) 
Alex’s low response to questions prompts a closer look. The Standard Utterance Lists, selected from 
the Analyze menu, displays lists of various types of utterances, including Questions, as well as their 
context within the sample. Using SALT to display the examiner’s questions along with the two 
subsequent entries is revealing. After examining these utterances more closely and listening to the 
audio, Alex’s low rate of responses to questions was likely due to the examiner asking consecutive 
questions. Alex did not have the opportunity to respond before the next question was asked. His 
failure to respond to questions was pragmatically appropriate. 
 

 
Figure 9-37 
 
Analyze Menu: Verbal Facility Summary (Figure 9-38) 
Thirteen percent of Alex’s total words were contained in mazes, which is higher than expected (8% is 
typical for 13-year-olds) and interferes with getting his intended message across. His mazes 
averaged 2.10 words in length. The mazes consisted primarily of phrase-level revisions. Filled pauses, 
e.g., er and um, were also frequent throughout Alex’s sample. 
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Figure 9-38 
 
Analyze Menu: Utterance Code Table (Figure 9-39) 
 
There were three utterance-level errors in Alex’s language sample. These utterances are shown in 
the Utterance Code Table for further investigation. Alex switched tenses within the same utterance. 
This occurred when he attempted longer (more complex) utterances as in the first utterance shown 
in the table. This tendency to switch tenses makes utterances awkward and difficult to comprehend 

Figure 9-39 
 
Analyze Menu: Subordination Index (Figure 9-40) 
The Subordination Index (SI) was completed on Alex’s sample. The SI measures clausal density and is 
computed by dividing the total number of clauses by total number of C-units (see Appendix O). Alex 
scored a 1.3, meaning most of his utterances consisted of one clause (40 utterances with a score of 
SI-1). Alex had nine utterances with two clauses and five utterances with three clauses.  
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Figure 9-40 
 
Explore Menu: Utterances Coded as [SI-3] (Figure 9-41) 
The Explore menu was used to pull up the five utterances which contained three clauses (coded as 
[SI-3]). Four of the five utterances contained direct quotes which increased the number of clauses 
without, necessarily, increasing sentence complexity. 
 

 
Figure 9-41 
 
INTERPRETATION 
 
Performance Profile   
Alex’s sample showed a fast speaking rate with low semantic content. This profile of language 
disorder features accelerated speaking rate (high WPM), high turn length, high MLU, and less 
complex sentence use. It is supported by Alex’s elevated turn length which was more than four times 
longer than the examiner’s turns. His messages were not always effectively completed as indicated 
by frequent rephrasing, circumlocutions, and filled pauses. He also had limited content given his high 
MLU and NDW, and less mature clausal structure. 
 
Strengths 
Alex used a variety of words in his language sample as seen by the high NDW. He was friendly and 
completed the task with enthusiasm. He also stayed on topic during the conversation, and 
responded appropriately to questions.  
 
Challenges 
Alex’s speaking rate was fast which made his language hard to follow at times. Alex talked more than 
twice as much as his conversational partner. He tended to be verbose and didn’t often allow his 
speaking partner to “chime in.”  He tended to rush to complete his thoughts as evidenced by revised 
word selection and sentence structure as well as utterance-level errors. Combined, these 
characteristics made his language relatively difficult to understand. Alex’s SI score indicated that he 
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used mostly one-clause utterances, a simplified sentence structure. His utterance-level errors 
occurred when he attempted longer, more complex utterances.  
 
Clinical Impressions 
This conversational sample allowed for careful examination of Alex’s speaking rate in relation to a 
speaking partner, his responsiveness to that partner, and his ability to express coherent utterances 
syntactically and semantically. The sample showed overall thought organization problems since 
Alex’s mazes consisted mostly of phrase-level revisions and filled pauses. With repeated samples, his 
progress on intervention goals can be tracked. It might also be beneficial to elicit an expository 
sample to monitor his progress. An expository sample might better provide an opportunity to 
examine semantic content, syntax, and overall text organization.  
 
Ideas for Intervention 
 Organization: language-based planning activities using the expository template or the narrative 

scoring categories as targets 
 Generate utterances using various subordinating conjunctions to create more complex sentences 
 Guided speaking rate practice using a metronome or digital counter 
 Practice slower speaking rate with known content like story retelling or expository tasks  



 

SALT Transcripts: Sam DDS Pre.slt & Sam DDS Post.slt13 
 
This case study was contributed by Maureen Gonter, M.S., CCC-SLP and Jane Morgan, M.S. Speech 
and Language/AVID Resource Teacher from Madison Metropolitan School District. 
 
BACKGROUND: RtI PROGRAM 
 
This case study is an example of how to use language sample analysis as part of assessing a Response 
to Intervention (RtI)14 program. This RtI study was completed with 6th grade students who were 
selected based on: 
 lower scores on 5th grade Wisconsin Knowledge and Concept Examination (WKCE), a state 

standardized test 
 6th grade Scholastic Reading Inventory score (fall semester) 
 teacher recommendations based on moderate difficulty meeting 6th grade standards across 

academic areas 
 outcomes of Assessment of Classroom Communication and Study Skills, a 6th grade whole class 

screener 
 
Students in the RtI program were involved in a literacy intervention group and were seen for 15 
sessions over 10 weeks during the course of one school quarter. The students received Tier 2 literacy 
instruction focusing on four areas: reading, writing, listening, and speaking. The focus of the 
intervention was to teach the students specific strategies and then give them opportunities to 
practice and apply the strategies to classroom activities and tasks. For example, the students were 
given a strategy to use in the classroom to signal to the teacher if they were having difficulty with 
vocabulary (make a “v” with two fingers) or understanding content/ideas (make a “w” for “what?” 
with three fingers). In this case study we look at one specific student, Sam, and his response to 
intervention. 
  
BACKGROUND 
 
In the classroom, Sam struggles with staying focused and on task. He engages in off-task behaviors 
which distract others such as humming and singing. He particularly struggles with attention and 
focus during math. Teachers believe this is because math is a more challenging subject for him. If the 
task is more engaging, Sam is better able to focus. He sometimes does not attempt tasks if he feels 
he will not be successful. He tends to do better on tasks that allow him to be creative. His language 
sample scores seem to reflect his functioning in the classroom (as measured by the Assessment of 
Classroom Communication and Study Skills) better than the results of his standardized testing. 
 
STANDARDIZED TEST INFORMATION 
 
Peabody Picture Vocabulary Test-4th Edition (PPVT-4), Form A 

Pre RtI Therapy Program:  
 Standard Score: 104,  
 Percentile:  61 
 Age Equivalent:  13;5 

Score on the on the PPVT-4 was within normal range. Sam used verbal mediation throughout 
this assessment. He would comment about word parts, rhymes, or other connections he could 
make as he tried to figure out the meaning of an unfamiliar word. 

                                                            
13 Sam DDS Pre and Sam DDS Post are sample transcripts included with the software. 
14 Response to Intervention is a variation of an old diagnostic method formerly known as Diagnostic Therapy 
(Miller, 1981) and later as Dynamic Assessment (Olswang, Bain, & Johnson, 1991). 

Case Study 7: SAM 
Response to Intervention 
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INFORMAL MEASURES 
 
Assessment of Classroom Communication and Study Skills 

 Reading Comprehension  1 of 4 points 
 Following Directions 7 of 20 points 
 Language Detective 2 of 5 points 
 Vocabulary 8 of 10 points 

 
 Total  18 of 39 points 
 Percentage 46%      (> 70 % is considered passing) 

Narrative Language Sample 
Sam retold the story Doctor De Soto (Steig, 1982) using the book with the text covered as per the 
elicitation protocol (see Appendix I). A retell sample was collected at the beginning of the RtI 
program and then again after participating in the 8-10 week intervention.  
 
The focus in this case study is on the differences seen between the pre and post intervention 
language samples. Using the Link menu in SALT, Sam’s pre and post samples were linked for side-by-
side analysis with the samples equated by the same number of total words (NTW = 545). Sam’s 
linked samples were compared to age-matched peers retelling the same story selected from the 
Narrative Story Retell database (see Appendix I).  
 
Selected database samples Pre RtI:  

79 samples matched by age: 11;7 – 12;7  
31 samples matched by age and same number of total words (NTW)  

 

Selected database samples Post RtI:  
55 samples matched by age: 11;10 – 12;8  
24 samples matched by age and same number of total words (NTW)  
 

SALT ANALYSIS 
 

Database Menu: Standard Measures Report (Figure 9-42) 
The Standard Measures Report shows the results of the pre and post samples with the relevant 
standard scores for each of the standard measures.  
 Transcript Length: In each story retell Sam used an adequate number of utterances and retold the 
narrative in average elapsed time.  

 Macro Analysis: Sam’s NSS Composite Score, which measures narrative structure and content, 
increased from 17 (1.79 SD below the database mean) to within normal limits at 26 (0.34 SD above 
the database mean).  

 Syntax/Morphology: His mean length of utterance in morphemes (MLUm) was low in both retells. 
MLUm was 9.27 (1.32 SDs below the mean) on his first retell which but increased to 10.33 (0.69 SD 
below the database mean) on his second retell. His SI Composite Score, a measure of clausal 
density, was also low for both retells, but increased from 1.20 in the first retell to 1.43 in the 
second retell. 
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Figure 9-42 Standard Measures Report based on entire transcript 
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 Semantics: Sam used a higher number of different words (NDW) on his second sample. 
 Verbal Facility: Areas of challenge included increased pause times and increased mazes. Sam’s 
pause time increased significantly from 3.5% of total time on his first sample to 12.9% on the 
second sample, although both were within normal limits. Sam’s mazes also increased in the 
second sample – from 18.5% of words to 21.7%.  

 Errors: Sam’s first retell contained 4 omissions while there were no omissions in his second retell. 
Error codes, however, increased from 3 in his first retell to 6 in his second retell even though the 
number of errors was within normal limits 

 

Additional information is provided in subsequent reports. 
 
Database Menu: Narrative Scoring Scheme (Figure 9-43) 
Sam’s sample was scored using the Narrative Scoring Scheme (NSS, see Appendix P) specific to the 
story Doctor De Soto. The NSS is a tool to assess the structure and content of a narrative. The 
narrative is scored on seven features of a narrative such as introduction, character development, 
mental states, and referencing, for a total of 35 possible points. Sam’s composite score on the NSS 
was 17 (1.79 standard deviations below the mean) on the first assessment and increased to 26 (0.34 
standard deviations above the mean) on the post-therapy assessment.  
 

 
Figure 9-43 
 
Database Menu: Subordination Index (Figure 9-44) 
The Subordination Index (SI, see Appendix O) measures clausal density and is computed by dividing 
the total number of clauses by total number of C-units. The SI was calculated and compared to the 
database of peers for both pre and post intervention assessment. The pre-treatment score was 1.20 
(1.90 standard deviations below the mean) and the post-treatment score was 1.43 (0.67 standard 
deviations below the mean) indicating that Sam used utterances with more clauses, i.e., increased 
syntactic complexity, in the post-intervention sample. He had more scores of [SI-2] and [SI-3] in the 
second sample. His scores showed a decrease in utterances marked as [SI-0]. 
  

 
Figure 9-44 SI based on first 545 words 
 
 



140  Assessing Language Production Using SALT Software  

 
Database Menu: Verbal Facility Summary (Figure 9-45) 
The Verbal Facility Summary indicated that Sam used an abundance of pauses during his second 
story retell as compared to his first story retell. Over 12 percent of his total time retelling the story 
was spent in a pause.  He had 12 pauses throughout his language sample. This is in stark contrast to 
his first story retell where he rarely paused. Sam used more mazes in his second sample than his 
first. His percent maze words to total words increased from 18.5% to 21.7%. His mazes were mostly 
phrase revisions which may indicate utterance formulation difficulty 
  

 
Figure 9-45 
 
Analyze Menu: Standard Utterance Lists (Figure 9-46 & Figure 9-47) 
The Standard Utterance Lists, selected from the Analyze menu, displays lists of various types of 
utterances, including utterances with errors and utterances with parenthetical remarks. 
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 Standard Utterance Lists  Error Codes (Figure 9-46) 
There were more word-level errors in the second sample than the first with an increase from 
three errors to six. The errors that Sam made seemed to be varied with no specific pattern. His 
language sample included errors in overgeneralization, word choice, conjunctions, and tense 
markers.  

Figure 9-46 
 

Figure 9-47 
 
 Standard Utterance Lists  Parenthetical Remarks (Figure 9-47) 

Parenthetical remarks are comments that to do not contribute to the story. They are excluded 
from analysis and marked in ((double parentheses)). Sam used an abundance of parentheticals 
that mostly related to word retrieval or perhaps working memory difficulty. He specifically 
stated, “What’s his name?”, “I’m just going to say doctor”, “I don’t remember”, and “I don’t 
know.”  There were significantly less parenthetical remarks in the second sample than in the first 
sample.  

 
INTERPRETATION 
 
Performance Profile 
Sam’s oral language skills best fit with the word retrieval and utterance formulation profile. His 
language samples are characterized by increased mazes and frequent utterances where Sam stated 
he “can’t remember” words. Additionally, Sam’s samples were marked by pauses that occurred 
within utterances, usually within mazes, which indicates utterance formulation difficulty. 
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Strengths 
Subsequent to the intervention phase, Sam’s MLU in words increased as did his syntactic complexity 
and vocabulary diversity. He had a decrease in word omissions. He improved his Subordination Index 
score indicating that he used more complex utterances after completing the intervention. He also 
increased his narrative structure and content score demonstrating improved organization and 
content of his narrative. He also increased the structural components of his narrative in the areas of 
cohesion, introduction, and conclusion.  
 
Challenges 
Sam was responsive to intervention as seen by the many areas of improvement. However, he 
continues to demonstrate difficulty with organization, word retrieval, and utterance formulation. He 
also had significant amount of pausing. Difficulty in these areas was highlighted in his second 
narrative retell. As many of his syntactic and semantic features improved, he demonstrated 
increased difficulty with mazes and pauses. He used more complex syntax with richer vocabulary but 
with more difficulty.  
 
Clinical Impressions 
Sam’s attempts at longer and more complex utterances support that he is generalizing his increase 
in MLU and NDW, the strategies learned, and the general language learning from the intervention 
program. As he attempted the longer and more complex utterances, his mazes, pauses, and 
utterance-level errors increased. These increases likely reflect the production challenges to Sam’s 
language system and his struggle to put what was learned into practice. Sam’s improved NSS and SI 
scores also support these impressions.  
 
Sam would most likely not be a candidate for speech and language programming within a special 
education program since he was responsive to intervention and many of his language measures are 
now within functional limits. As Sam begins 7th grade the following suggestions might help him be 
more successful in his academic classes:   
 
Ideas for Intervention 
 Consult with parents at the start of the school year to provide word retrieval and language 

formulation strategies. 
 Encourage Sam to take his time to formulate and organize thoughts before speaking. 
 Consult with teachers to provide reminders and cues to use with Sam during classroom 

discussions and/or presentations. 
 Suggest placement in a supported Social Studies classroom where large group vocabulary 

instruction and language activities occur once per month. Keep monthly data to monitor his 
progress. 

 Provide Sam with a visual reminder of the RtI strategies to be kept in his planner 
 
 
 


